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1.0. OBJECTIVE:

To lay down the procedure for safe and smooth Operation and Calibration of Kaye Validator-
2000 system.

2.0 SCOPE:
This SOP is applicable to Kaye Validator 2000.

3.0 RESPONSIBILITY
3.1 Trained Personnel shall be responsible for operation of Kaye Validator.
3.2 Trained Personnel shall be responsible for the calibration of Temperature sensors.

3.3 Assistant Manager and above of QA department shall be responsible for the verification of the

equipment operation as per the written procedure.

4.0. ACCOUNTABILITY:
Head QA

5.0 PROCEDURE:
This section describes the steps necessary to:
= Start the Validator 2000 software
= Create/ modify a setup
= Connect the system
= Calibrate sensors
= Run the qualification study
= Verify sensor calibration
= Create reports from study data

= Access the audit trail
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5.1 Starting The Validator 2000 Software
511 On the taskbar, click the Start button, point to Programs, point to VValidator 2000, and
then click Validator 2000. In case of any major changes in the system, equipment or
process.
5.1.2 The Validator 2000 screen appears, followed by the Main Menu. The Main Menu provides
access to the major functions of the Validator 2000 software.
5.2 Creating/Modifying a Setup
521 The setup defines everything required to calibrate sensors, run qualification studies, and
verify sensor calibration. The setup is created/modified using the Validator 2000 software.
The PC does not have to be connected to the Validator 2000 to create/modify setups. In
case of failure in requalification study the non-compliance shall be handled as per the
“Handling of Deviation”.
522 Procedure
5221 On the Main Menu, click Define Setups
5222 The File Selection screen appears. Existing setups are listed by the date and time the files
were saved.
= To create a new setup, click New, enter up to 35 characters to describe the setup, and
click OK.
= To modify an existing setup, select the setup from the file list and click OK.
= The Sensors screen appears.
52.2.3 Add, modify or delete sensor definitions as necessary

= Select sensors by clicking a sensor location or clicking and dragging the pointer over

multiple sensor locations in the same SIM.
= The Sensor Definition screen appears.

= To add or modify a sensor definition, enter/modify the sensor label and sensor

description, and select a sensor type. Specify scale factors as required. To
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5.2.2.4

5.2.25

5.2.2.6

5.2.2.7

automatically number multiple sensor definitions, select both Automatic Numbering
check boxes to append 2 digits in sequence to the sensor label and description label.
Click OK.

= To delete sensor location(s), click Delete. Click Yes when prompted to delete sensors.
Identify/modify groups
= Click the Groups tab.

= Change group titles or add groups as necessary (up to 4 groups, 35 characters) in the

group list box.
Assign sensors to groups
= Click the Sensor Selection tab (if not already displayed).
= Select a group from the list box.
= Assign sensor locations as necessary.
= Repeat for all groups as necessary.
Specify group calculations and events.
= Click the Calculations tab.
= Select a group from the list box.
= Specify group calculations as necessary.
= Define the group event (one per group) as necessary.
= Repeat for all groups as necessary.
Specify report header information.
= Click the Report Header tab
= Select a group from the list box.
= Enter/modify report header information as necessary.

= Repeat for all groups as necessary
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5.2.2.8

5.2.29

5.2.2.10

Specify calibration parameters.

= Click the Calibration tab

= Set the Temperature Set points as necessary.
= Set the Stability Criteria as necessary.

= Set the Deviation Criteria as necessary
Specify qualification study conditions.

= Click the Qualification tab.

= Click the Modify button.

= The Start/Stop Conditions screen appears.

= Set the Start/Stop Conditions as necessary and click OK.

= Set the Data Storage File Rate and Validator 2000 Printer Rate as necessary.

= Set the Scan Rate to appropriate rate (8 inputs or 12 inputs per second).
= Set the Output Relay as necessary.

Save the setup file.

= Click the File Topics tab

= The Setup Files screen appears.

= Click Save.

= The Identification Required dialog box appears.

= Enter user ID and password and click OK.

= The Save Setup File screen appears.

= For a new setup, enter a new setup file name, or accept current file name.
= For a modified setup, enter a new setup name.

= Click OK.

= The Setup Files screen appears
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5.3 Connecting the System
531 All system connections are on the back of the Validator 2000. Each connection port is
labeled with an icon representing its function. Connection ports are as follows:
= 2 IRTD ports (RJ11)
= 1 temperature reference port (RJ11)
= 1 PC serial communications port
= 1 parallel printer port
= 1 Relay NC/NO port
532 Procedure
53.2.1 Make sure the Validator 2000 and the temperature reference are powered off before
connecting the system.
5.3.2.2 Insert the IRTD into the temperature reference.
5.3.2.3 Connect the IRTD to one of the RJ11 sockets, using the M2810 cable supplied with the
IRTD.
53.2.4 Connect the temperature reference to one of the RJ11 sockets, using the W1885-1 cable
supplied with the temperature reference.
5.3.25 Connect the PC to the 9-pin port, using the 9 to 9-pin W1890-1 cable. If necessary, use a 9
to 25-pin adapter at the PC.
5.3.2.6 Connect the temperature reference power cable to a grounded power source.
5.3.2.7 Connect the Validator 2000 power cable to a grounded power source.
5.3.2.8 Insert the wired SIMs into the SIM slots. Label each SIM with the associated slot number.
5.3.2.9 Turn the temperature reference power switch to the ON position.
5.3.2.10 Turn the Validator 2000 power switch to the ON position.
54 Checking Hardware and Communications Connections
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54.1 The Validator 2000 software graphically displays the validation system hardware and
communications connections. It is good practice to check communications before starting
the validation process.

54.2 Procedure

5421 Click the Hardware tab. Each hardware item is shown with a communication link. A
Device Not Found symbol ¥4 indicates a communication problem.

5.4.2.2 Click any Device Not Found symbol %4 to get help for that particular problem.

55 PC-Controlled Operation
This section includes procedures for operating the Validator 2000 from the PC.
Procedures include sensor calibration, running a qualification study, and verifying
sensor calibration.

5.6 PC-Controlled Sensor Calibration
Calibrate sensors before running the qualification study. When performing PC-
controlled sensor calibration, all major actions should be performed at the PC.

56.1 Procedure

56.1.1 Place the Validator 2000 in a location with stable and even temperature, not exposed to any
local heat sources (i.e., close to a sterilizer, an open door causing a draft, etc.).

5.6.1.2 Power up the Validator 2000 and let it run for approximately 30 minutes in the operating
environment in order to acclimate to the ambient temperature.

5.6.1.3 Insert the thermocouple sensors into the temperature reference.

5.6.1.4 At the PC, close all open applications and disable all power-conserve and screen saver
features.

5.6.1.5 Start the Validator 2000 software if not already running.

5.6.1.6 Load the setup from the PC into the Validator 2000.

= On the Main Menu, click Calibrate Sensors.
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= The File Selection screen appears, listing all setup files in the default data path.
= Select the setup to be used for the qualification study and click OK.
= The Identification required dialog box appears.
= Enter user ID and password and click OK.
= The Select Sensors screen appears.
5.6.1.7 Select sensors to calibrate.
= To select individual sensors, click each sensor location.
= To select multiple sensors in the same SIM, click and drag the pointer over the sensor
locations.
= To select all sensors in the same SIM, click Select All.
5.6.1.8 Calibrate sensors.

= Click Calibrate Sensors.

= Click Yes when prompted to initiate calibration.
= The Identification required dialog box appears.
= Enter user ID and password and click OK.

= The Validator 2000 automatically performs sensor calibration at the specified set

points.
= Click the Data tab to display sensor readings and stability and deviation values.
= Click the Status tab to view the status of the calibration process.

= When calibration is complete, the program prompts you to add a comment to the

calibration file. Click Yes to enter a comment, No to continue.
= The message "The final data record has been received from the Validator" appears.
= Click OK.

= On the Data screen, click Return.
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= The Select Sensors screen appears. Calibrated sensors are displayed with a pound sign
(#).
5.6.1.9 Return to Main Menu.
= Click the File Topics tab.
= The Calibrate Sensors screen appears.
= Click Main to return to the Main Menu.
5.7 PC-Controlled Qualification Study
The Validator 2000 can perform PC-controlled qualification studies manually,
automatically, or in combination, depending on the start/stop conditions defined in the
setup. When performing a PC-controlled qualification study, all major actions should be
performed at the PC.
57.1 Procedure
5711 If not already on, power up the Validator 2000 and let it run for approximately 30 minutes
in the operating environment in order to acclimate to the ambient temperature.
5.7.1.2 Position sensors in vessel or chamber being tested.
5.7.1.3 At the PC, close all open applications and disable all power-conserve and screen saver
features.
57.14 Start the Validator 2000 software if not already running.
5.7.15 Load the setup from the PC into the Validator 2000.

= On the Main Menu, click Run Qualification.

= The File Selection screen appears.

= Select the setup and click OK.

= The Report Header screen appears.

= Enter/modify report header information for each group as necessary.
= Click the Qualification tab.

= Click Load Setup.
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= The Identification required dialog box appears.
= Enter user ID and password and click OK.
= The Status screen appears.
5.7.1.6 Start the qualification study. If the start condition is defined as Manual:
= Click Start Qualification Study.
= The Identification required dialog box appears.
= Enter user ID and password and click OK.
5.7.1.7 View/graph qualification study data. This step can be performed at any time during the
qualification study.
= Click the Status tab to view group event status.
= Click the Values tab to view real-time sensor readings and calculations by group.
= Click the Messages tab to view real-time events.
= Click the Graphs tab to graph real-time sensor readings and calculations by group.
= Click the Sensor Offsets tab to view sensor offsets from the most recent calibration.
5.7.1.8 Start the exposure cycle. If the start condition is defined as Manual:
= Click Start Exposure Cycle on the Status screen, or click Start Exp on the Values,
Messages or Graphs screens.
= The Identification required dialog box appears.
= Enter user ID and password and click OK.
5.7.1.9 Stop the exposure cycle. If the stop condition is defined as Manual:
= Click Stop Exposure Cycle on the Status screen, or click Stop Exp on the Values,
Messages or Graphs screens.
= The Identification required dialog box appears.
= Enter user ID and password and click OK.
5.7.1.10 Stop the qualification study. If the stop condition is defined as Manual:
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= Click Stop Qualification Study on the Status screen, or click Stop Qual on the
Values, Messages or Graphs screens.
= The Identification required dialog box appears.
= Enter user ID and password and click OK.
= When the qualification study has ended, the program prompts you to add a comment
to the qualification file. Click Yes to enter a comment, No to continue.
= The message "The final data record has been received from the Validator" appears.
Click OK.
= Click Done on the Status, Values, Messages or Graphs screens.
= The Qualification screen appears.
5.7.1.11 Return to the Main Menu.
= Click the File Topics tab.
= The Run Qualification screen appears.
= Click Main to return to the Main Menu.
5.8 PC-Controlled Calibration Verification
Verify sensor calibration after running the qualification study. When performing PC-
controlled calibration verification, all major actions should be performed at the PC.
5.8.1 Procedure
58.1.1 If not already on, power up the Validator 2000 and let it run for approximately 30 minutes
in the operating environment in order to acclimate to the ambient temperature.
5.8.1.2 Insert the thermocouple sensors into the temperature reference.
5.8.1.3 At the PC, close all open applications and disable all power-conserve and screen saver
features.
5.8.14 Start the Validator 2000 software if not already running.
5.8.1.5 Load the setup from the PC into the Validator 2000.

= On the Main Menu, click Calibrate Sensors.
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= The File Selection screen appears.
= Select the setup used to perform the qualification study and click OK.
= The Identification required dialog box appears.
= Enter user ID and password and click OK.
= The Select Sensors screen appears.
5.8.1.6 Select sensors to verify.
= To select individual sensors, click each sensor location.
= To select multiple sensors in the same SIM, click and drag the pointer over the sensor
locations.
= To select all sensors in the same SIM, click Select All.
5.8.1.7 Verify sensor calibration.

5.8.1.8

= Click Verify Calibration.
= The Identification required dialog box appears.
= Enter user ID and password and click OK.

= The Validator 2000 automatically performs calibration verification at the specified set

points.
= Click the Data tab to display sensor readings and stability and deviation values.
= Click the Status tab to view the status of the calibration verification process.

= When calibration verification is complete, the program prompts you to add a comment

to the calibration verification file. Click Yes to enter a comment, No to continue.
= The message "The final data record has been received from the Validator" appears.
= Click OK.
= On the Data screen, click Return.

= The Select Sensors screen appears.
Return to the Main Menu.
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5.9

5.10

5.10.1
5.10.1.1

5.10.1.2

= Click the File Topics tab.
= The Calibrate Sensors screen appears.

= Click Main to return to the Main Menu.

Generating Reports

Reports are generated from secure data files that can only be read by the Validator 2000
software. Reports are not saved; you create reports each time from the secure data files.
You can generate Setup, Calibration, Qualification, and Calibration Verification
Reports to document the specifics of your validation study. If Adobe Acrobat Version
5.0 with Acrobat PDF Writer is installed on your PC, you can create Portable Document
Format (PDF) files from the study data.

Generating Setup Reports

Setup Reports can be generated individually or as part of the Qualification Report set if
the setup file was used for a qualification study. This section documents the procedure
for generating an individual Setup Report.

Procedure:

Select the report file.

= On the Main Menu, click Create Reports.
= The Report Files dialog box appears.

= Select Setup and click OK.

= The File Selection screen appears, listing the setup files available in the default data

path.
= Select the file to document and click OK.

= The Format screen appears.

Format report output.

= The "Performed by / Date" and "Reviewed by / Date" options are enabled by default.

Click one or both options to exclude these signature lines from your report.
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= If you included one or both signature line options in your report format, but do not
want signature lines on every report page, clear the Every Page option. The First
Page and Last Page options are then selected by default. Select one or both options as
required.
= Click the File Topics tab.
= The Report Files screen appears.
5.10.1.3 Preview the report and/or create a PDF file.
= Click Preview.
= The first page of the Setup Report appears in the Print Preview window.
= To preview the report, use the scroll bars, or click and drag the mouse, to navigate
through the displayed report page. Use the spin buttons to page through the report, or
enter a page number directly and press Enter to go to that page.
= To create a PDF file from the report, click PDF. On the Output PDF File screen,
specify the folder to save the file in, enter a file name, and click OK.
= Click Done to return to the Report Files screen.
5.10.1.4 Print the report.
= On the Report Files screen, click Print.
= Select a printer on the Print dialog box and click Print.
= Click Main to return to the Main Menu.
511 Generating Calibration Reports
This section documents the procedure for generating Calibration Reports from data
stored during a sensor calibration.
5111 Procedure:
511.1.1 Select the report file(s).

= On the Main Menu, click Create Reports.

= The Report Files dialog box appears.
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= Select Calibration and click OK.
= The File Selection screen appears, listing the calibration files available in the default
data path.
= Select one or more files to document and click OK.
= The Format screen appears.
5.11.1.2 Format report output.
= The "Performed by / Date" and "Reviewed by / Date" options are enabled by default.
Click one or both options to exclude these signature lines from your report.
= |f you included one or both signature line options in your report format, but do not
want signature lines on every report page, clear the Every Page option. The First
Page and Last Page options are then selected by default. Select one or both options as
required.
= Click the File Topics tab.
= The Report Files screen appears.
511.1.3 Preview the report and/or create a PDF file.
= Click Preview.
= The first page of the first Calibration Report appears in the Print Preview window.
= To preview the report, use the scroll bars, or click and drag the mouse, to navigate
through the displayed report page.
= To create a PDF file from the report, click PDF. On the Output PDF File screen,
specify the folder to save the file in, enter a file name, and click OK.
= Click Done to display the next report and repeat step 3. If there are no more reports in
this series, the Report Files screen appears.
5.111.4 Print the report.

= On the Report Files screen, click Print.

= Select a printer on the Print dialog box and click Print.
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5.12

5.12.1
512.1.1

5.12.1.2

5.12.1.3

= Click Main to return to the Main Menu.

Generating Qualification Reports

The complete Qualification Report set includes the Setup, Qualification, and
Qualification Summary Reports.
Procedure

Select the report file.

= On the Main Menu, click Create Reports.
= The Report Files dialog box appears.

= Select Qualification and click OK.

= The File Selection screen appears, listing all qualification files stored in the default
data path.

= Select a Vessel 1D from the list box to filter the list to only those files containing that
Vessel ID.

= Select the file to document and click OK.

= The Print Options screen appears.

Specify the report types to be individually generated.

= The Setup, Qualification, and Summary report types are enabled by default. If you

do not want to generate an individual report type, click the option name to disable it.

= The Summary Report has two additional options if the setup specified these
calculations for any group. Select Lethality to include the total accumulated lethality
for each sensor in the Summary Report. Select Interval to include the final interval
calculation for each sensor in the Summary Report.

Specify the groups to include in your study documentation.
= All groups are selected by default (group name is highlighted).

= To exclude a group, click the group name. The excluded group name will no longer be
highlighted.
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5.12.1.4

5.12.1.5

5.12.1.6

5.12.1.7

Specify the print sampling rate.

= The print sampling option allows you to print the report data at a rate different from
the data collection rate. When the report is printed, time stamps in the qualification
data file that match the selected print sampling rate will be included, while all others

(except event times) will be suppressed.

= To specify the print sampling rate, select a rate from the Print Sampling list box.
Specify the print destination.

= The Printer option is enabled by default.

= Select the Spreadsheet option to export qualification data to an Excel spreadsheet
file. If you selected a print sampling rate, and only want to export events that occurred
at the new print sampling rate, select Exclude off-sample-rate events to suppress
events that do not occur in sync with the new print sampling rate. When you print the
report you will be prompted to name and store the spreadsheet file.

Format report output.
= Click the Format tab.

= The "Performed by / Date" and "Reviewed by / Date" options are enabled by default.

Click one or both options to exclude these signature lines from your report.

= |f you included one or both signature line options in your report format, but do not
want signature lines on every report page, clear the Every Page option. The First
Page and Last Page options are then selected by default. Select one or both options as

required.

= To add comments to the beginning and/or end of the Qualification and Qualification
Summary Reports, click the associated User comments option and enter comments in
the text box.

Add event timers.

= Click the Event Timers tab.
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5.12.1.8

5.12.1.9

5.12.1.10

= Select a message number from the Event Message list and enter the message to print

in the Qualification and Qualification Summary Reports.
= Specify start and stop conditions for the event timer.

* Repeat as necessary.

Exclude sensors from post-qualification calculations as necessary.
= Click the Groups tab.
= Select a group from the list box.

= Under the Sensor Selection tab, click individual sensor locations or click Deselect All

to exclude sensors from post-qualification calculations as necessary.

= Repeat for each group as necessary.
Add calculations and group events.

= Click the Calculations tab.

= Select a group from the list box.

= Add/modify group calculations as necessary.
= Add group events as necessary.

= Repeat for each group as necessary.

Preview individual reports and/or create a PDF file.

= Click the File Topics tab.

= The Report Files screen appears.

= Click Preview.

= The first page of the first report appears in the Print Preview window.

= To preview the report, use the scroll bars, or click and drag the mouse, to navigate
through the displayed report page. Use the spin buttons to page through the report, or
enter a page number directly and press Enter to go to that page.
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= To print that individual report, click Print. Select a printer on the Print dialog box and
click Print.
= To create a PDF file from that report, click PDF. On the Output PDF File screen,
specify the folder to save the file in, enter a file name, and click OK.
= Click Done to display the next report and repeat step 10. If there are no more reports
in this series, the Report Files screen appears.
5.12.1.11  Print the entire report set.
= On the Report Files screen, click Print.
= Select a printer on the Print dialog box and click Print. All reports in the series are
printed.
= |f the Spreadsheet option was selected, the Export File screen appears after the reports
have been printed. Enter a filename for the Excel file, select a drive and folder to store
the file, and click OK.
= Click Main to return to the Main Menu.
5.13 Generating Calibration Verification Reports
This section documents the procedure for generating Calibration Verification Reports
from data stored during sensor calibration verification.
5131 Procedure:
5.13.1.1 Select the report file(s).

= On the Main Menu, click Create Reports.
= The Report Files dialog box appears.
= Select Calibration Verification and click OK.

= The File Selection screen appears, listing the calibration verification files available in
the default data path.
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= To filter the list of files to display only those calibration verifications performed on or
after a specific date, click Date. Select the date of your calibration verification on the
calendar and click OK.
= To filter the list of files by serial number, select a Validator 2000 serial number from
the list box.
= Select one or more files to document and click OK.
» The Format screen appears.
5.13.1.2 Format report output.
= The "Performed by / Date" and "Reviewed by / Date" options are enabled by default.
Click one or both options to exclude these signature lines from your report.
= If you included one or both signature line options in your report format, but do not
want signature lines on every report page, clear the Every Page option. The First
Page and Last Page options are then selected by default. Select one or both options as
required.
= Click the File Topics tab.
= The Report Files screen appears.
5.13.1.3 Preview the report and/or create a PDF file.

= Click Preview.

= The first page of the first Calibration Verification Report appears in the Print Preview

window.

= To preview the report, use the scroll bars, or click and drag the mouse, to navigate
through the displayed report page. Use the spin buttons, or enter a page number and
press Enter to page through the report, or enter a page number and press Enter to go

to that page.

= To create a PDF file from the report, click PDF. On the Output PDF File screen,

specify the folder to save the file in, enter a file name, and click OK.
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= Click Done to display the next report and repeat step 3. If there are no more reports in
this series, the Report Files screen appears.
5.13.14 Print the report.
= On the Report Files screen, click Print.
= Select a printer on the Print dialog box and click Print.
= Click Main to return to the Main Menu.
5.14 Using the Validator 2000 Audit Trail
The Validator 2000 software maintains the audit trail, which contains all events and
identifies the type of action performed, the date and time the action occurred, the name
of the responsible operator, and any additional information required to understand the
action taken. A new audit trail file is automatically created each month and placed in
the Validator 2000 application folder.
5.15 Accessing the Audit Trail
Audit trail data is only available to the System Administrator through the Password
Maintenance utility program.
5.15.1 Procedure
5.15.1.1 Log in to the Password Maintenance utility program.
= Start the Validator 2000 PC program. Press ALT and S simultaneously when the
Validator 2000 splash screen appears.
= The Identification required dialog box appears.
= Enter System Administrator user ID and password and click OK.
= The Password Maintenance screen appears.
5.15.1.2 Access the audit trail.

= Click File, and then click Audit Trail.

= The Audit Trail screen appears.
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5.16 Filtering and Printing the Audit Trail
All events for the current month are displayed on the Audit Trail screen.
5.16.1 Procedure
5.16.1.1 Select the starting and ending dates of the audit trail.
= Click Options, and then click Dates.
= The Begin Audit Trail Display screen appears.
= Select the start date and click OK.
= The End Audit Trail Display screen appears.
= Select the end date and click OK.
5.16.1.2 Filter the audit trail by event type.
= Click Filter.
= Select a filtering option as necessary.
5.16.1.3 Filter the audit trail by Validator 2000 serial number.
= Click Options, select Source, and then click Validator: All.
= Click OK to view events for multiple Validator 2000s, or enter the Validator 2000
serial number and click OK to view events for a specific Validator 2000.
5.16.1.4 Print the audit trail.
= Click the printer icon.
= Select a printer on the Print dialog box and click Print.
5.16.1.5 Create a PDF file of the audit trail. You will need to have Adobe Acrobat Version 5.0 with

PDF Writer installed on your PC.

= Click the printer icon.

= Select Acrobat PDF Writer on the Print dialog box and click Print.
= The Save PDF File As screen appears.

= Enter the PDF file name, specify the folder to save the file in, and click Save.
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5.17 Backing up the Audit Trail
Audit trail files can be backed up to a local or network drive. To maintain data integrity,
audit trail files cannot be backed up to a removable drive.
517.1 Procedure
517.1.1 Backup the audit trail.
= On the Audit Trail screen, click File, and then click Backup.
= The Audit Trail Backup Directory screen appears.
= Specify the path where the audit trail files are to be copied and click OK.
= On the Audit Trail screen, click File, and then click Done.
» The Password Maintenance screen appears.
5.17.1.2 Click File, and then click Exit to exit the Password Maintenance utility.
5.17.1.3 Enter the entry into the log book after every operation
5.18 Calibration of Kaye Validator 2000 unit, LTR-25/ 140, HTR 400 and IRTD
Perform the Calibration of Kaye Validator 2000 unit, LTR-25/140, HTR 400 and IRTD
from the outside calibration agency (approved) at every one year.
6.0 REFERENCE:
SOP No. Title
Handling of Deviation
7.0 ANNEXURE:
Not Applicable
8.0 ABBREVIATIONS:

SOP : Standard Operating Procedure
No. : Number
Dept. : Department

Ltd. : Limited




